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Getting an Account Through the Information Technology Training 
Initiative (Michigan Virtual University): By Carole Colburn 

It is not too late to set up an account through the Information Technology Training 
Initiative with MVU. These free (yes, “FREE”) on-line training courses are available to 
use through May of 2003, and you can register on-line at any time. 

Some people have asked me how they can learn to use the computer by taking 
classes “on the computer?” That is a valid question, and one that can be answered 
easily. You see, if you know how to operate a tape recorder, you can no doubt operate 
the Web Player program that the courses use to run the class. All you have to know in 
advance is how to get to the site, open up the program and the basics of a couple of 
buttons (page forward, pause, and stop) that are similar to those found on a simple tape 
recorder or VCR. The classes themselves teach you the rest.  

There are over 700 class offerings, most of which are computer-related. There are, 
however, also some classes in Business Productivity, Financial Planning and Time 
Management. You can pick and choose whatever interests you. You may also receive 
SB-CEU credit for completing courses. More information about how to do that can be 
found at the website. 

Below, are instructions for how to get registered and begin using these on-line 
courses.  

 
 

1. Open Internet Explorer. 
2. Click in the Address Field and type www.mivu.org 

 

 
 

3. Click the Information Technology Training Initiative link in the middle of the page.  

http://www.mivu.org/


   

   
  

4. Next, if you want to sign up for an account, click New Users. 
 

 
5. When you click the New Users link, your screen should look something like this. 

Scroll down to the bottom of the page and click the button that says, “Yes, I’m 
Eligible” 

 

 
 

6. On the next page, click the bottom “Click Here” button. This will allow you to 
create your user profile. 

 



   

   
  

 
 

7. You must fill in the blanks with your personal information. Even though you only 
see six fields on this first page to fill in, there will be three additional fields that will 
pop up. You will have to include your Intermediate School District (Livingston 
ESA), your School District (Howell Public Schools) and the building you work in. 
When you have completed all of this information, click “Finish Now.” 

 

 



   

   
  

 
8. Once you have created your profile, click the Browse Category link on the left 

side of the screen.  It will open a page that looks something like this. 
 

 
 
 
 

9. Browse through the general categories until you find the courses you are 
interested in taking. If you are interested in learning more about how to use 
Word, Power Point, Excel, etc., click the Computer Literacy & Application 
Software link.  This will open a page that looks something like this. 

 

 

 

 
10. When you click the Microsoft Office 2000 link, a page will open showing you all 

the courses available in this category. 
 
 



   

   
  

 
 
 
 

11. If you click on any of the courses, this will open a page that will give you a lot of 
information about that particular course, including a Course Overview, the 
Course Objectives and the topics covered in each unit. 

 

 
 



   

   
  

12. If you click the “Take it Free” link, this class will be added to your Learning Plan. 
If you click the “Learning Plan” link on the left side of the page, you will see a list 
of all the courses you have elected to take. This is my learning plan. 

 
 

 
 
 
 
 
 

13. To start a course, simply click the Start link next to the course you want to begin. 
 

 
 
 

14. ***To log in from any computer with Internet access, simply go to the 
www.mivu.org site, click the Information Technology Training Initiative link, click 
the Log-In link and type you e-mail address and password and finally, click 
“Submit.” 

 

http://www.mivu.org/


   

   
  

 

 
 
***This will bring you to your own “Learning Plan” page.  

 
 

  
 

Back to Top of Page 
 
 
FYI: Teachers who received TTI equipment will be asked to submit a follow up as soon as it becomes 
available on the MVU website.  This survey should reflect what they put into their original tech plan and how 
they are using the equipment from the TTI program. 

FYI: ABACUS training will be taking place at each of the schools during the month of February. ABACUS is 
the curriculum management component to SASI xp and is a great tool for teachers to use to correlate lessons 
with the state standards and benchmarks. Look at the Training Calendar link at 
http://www.howellschools.com/~training/index.html to see the days and times training will be offered at your 
building.  

Back to Top of Page 

  

Lesson Plan of the Month 

The following lesson plan comes from: http://www.bestpractices.cc/bstpractNew/SpecialEdMS.html 

MAISA and the REMC Association of Michigan 
Best Practices in Technology Integration Plan 
 
Title: Real Estate Project 

http://www.howellschools.com/~training/index.html
http://www.bestpractices.cc/bstpractNew/SpecialEdMS.html


   

   
  

Submitted By: Colleen Schaeding 
School District: Swan Valley School District 
School: Swan Valley Middle School (Saginaw, Michigan) 
 
Subject(s): Language Arts (Reading and Writing), Math, Technology, 
Employability and Life Skills 
Intended Grade Level(s): Developed for 6th, 7th, & 8th Grade Special Education Students, 
but could effectively be used with regular education students as well. 
 
Description: 
This is a Unit Plan for a REAL ESTATE PROJECT. In class, students begin by brainstorming 
about what they like about their favorite room at home. They then incorporate these ideas into a 
paragraph (writing process). Using creative skills, they create “shoe box” houses that represent 
what they believe is ideal. Their houses include the “favorite room” described in the paragraph. 
When the house is finished, students glue the parts of the paragraph to their house: topic sentence 
is attached to roof, supporting ideas to the walls, and concluding sentence to the foundation 
(understanding paragraph writing). 
 
Next, students will use the INTERNET to examine real estate ads. They will look carefully at 
what is included in the ad (total square feet, # of rooms, size of rooms, etc.). Following this 
activity, students will write paragraphs describing their (created) houses. They discuss audience 
and try to determine who will be reading their ads. At home, they measure rooms to get ideas of 
room sizes. 
 
Finally, they turn paragraphs into ads, replacing complete sentences with phrases, noting that 
words in ads cost money, and real estate agents are concerned about budgets. Pictures are taken 
with a DIGITAL CAMERA of students (agents) and houses, and worked into a (WORD 
PROCESSING/DRAWING) real estate ad by student. 
 
Curriculum Benchmarks: 
MI.ELA.1 Read and comprehend general and technical material 
MI.ELA.2 Demonstrate the ability to write clear and grammatically correct sentences, 
paragraphs, and compositions 
MI.ELA.3 Focus on meaning and communications - they listen, speak, view, read, and write in 
personal, social, occupational, and civic contexts 
MI.ELA.4. Use the English language effectively 
MI.ELA.6. Learn to communicate information accurately and effectively and demonstrate their 
expressive abilities by creating oral, written, and visual texts that enlighten and engage the 
audience 
MI.ELA.7. Demonstrate, analyzes, and reflects upon the skills and processes used to 
communicate through listening, speaking, viewing, reading, and writing 
MI.ELA.8. Explore and use the characteristics of different types of texts, aesthetic elements, and 
mechanics - including text structure, figurative and descriptive language, spelling, punctuation, 
and grammar - to construct and convey meaning 
MI.ELA.10. Apply knowledge, ideas, and issues drawn from texts to their lives and the lives of 
others 
MI.MAT.I.1 Recognize similarities and generalize patterns, use patterns to create models and 
make predictions, describe the nature of patterns and relationships, and construct representations 
of mathematical relationships; 



   

   
  

MI.MAT.II.1. Develop spatial sense, use shape as an analytic and descriptive tool, identify 
characteristics and define shapes, identify properties and describe relationships among shapes 
MI.MAT.II.2. Identify locations of objects, identify location relative to other objects, and 
describe the effects of transformations (e.g., sliding, flipping, turning, enlarging, reducing) on an 
object 
MI.MAT.III.3. Compare attributes of two objects, or of one object with a standard (unit), analyze 
situations to determine what measurement(s) should be made and to what level of precision 
MI.MAT.III.1. Collect and explore data, organize data into a useful form, and develop skill in 
representing and reading data displayed in different formulas 
MI.MAT.IV.1. Experience counting and measuring activities to develop intuitive sense about 
numbers, develop understanding about properties of numbers, understand the need for and 
existence of different sets of numbers, and investigate properties of special numbers 
MI.MAT.IV.2. Recognize that numbers are used in different ways such as counting, measuring, 
ordering and estimating, understand and produce multiple representations of a number, and 
translate among equivalent representations 
MI.MAT.V.1 Understand and use various types of operations (e.g., addition, subtraction, 
multiplication, division) to solve problems 
 
Materials/Hardware/Software: 
The Internet 
Digital Camera 
Word Processing Program (Claris Works was used, any word processing program can be used) 
Drawing Program (Claris Works Drawing was used, any drawing program can be used) 
 
Activities/Procedures: 
The activities/procedures were briefly explained in the description of the project. The central 
question the teacher is asking is what type of writing is best suited to advertising? 
Key questions for students in this project would be:  
What is your favorite room in your house? 
What makes that room stand out from the rest? 
If you were going to sell a house, what features do you think prospective buyers would be most 
interested in? 
What descriptive word would attract buyers? 
How can you condense paragraphs into phrases that catch the reader’s attention? 
 
Activities listed in order: 
� Students brainstorm about their favorite room in their houses, about what makes that 

room special.  
� Teacher does the same.  
� Everyone writes a paragraph describing his or her favorite room.  
� Class edits teacher’s paragraph together, replacing boring, factual language with 

interesting, descriptive phrases. 
� Students plan a “dream house,” including their favorite rooms.  
� Then, they create their houses out of shoeboxes, including all features they think are 

important to a house. Students attach the parts of their paragraphs to their houses, as 
described earlier (topic sentence to roof, etc.). 

� Next, students examine actual real estate ads on the Internet. They look at sizes of rooms, 
total square feet, and other features listed. They measure rooms of their own houses to 
compare sizes and get an idea of how rooms at home compare to the ones in the ads. 



   

   
  

 
 
� Now students write paragraphs describing the complete house they each created, 

remembering to write to keep the audience (buyers) interested. 
� Finally, students convert paragraphs to ads, replacing sentences with catchy phrases. 
� Using a digital camera, pictures of students and their houses are taken and put into a word 

processing real estate “ad”, utilizing the descriptive phrases from paragraphs written 
earlier. 

 
Assessment/Evaluation: 
Each phase of the project will be evaluated, as well as the final project. (Example: paragraph 
writing - Is there a good topic sentence, supporting ideas, and a conclusion? house - Is it 
attractive? Complete?) 
 
Follow-up Activities: 
In class, students will informally evaluate houses and real estate ads. 
Ads will be put on display, with houses, in the school showcases for everyone to see and provide 
feedback on. 
 

***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  

 

Back to Top of Page 

  

 Carole’s Training Corner  
Welcome to February! As I mentioned last month, this month, much of the training will focus on ABACUS. 
I have already been to many of the buildings to train staff, but if you have not received notice you can 
check out the days and times I will be at your school at: 
http://www.howellschools.com/~training/TrainingCalendarPage.htm  

For those of you who are not aware of ABACUS, it is the curriculum management component to SASI xp 
that allows you to access the HPS District curriculum that is correlated to state standards and 

mailto:colburnc@hps.k12.mi.us
http://www.howellschools.com/~training/TrainingCalendarPage.htm


   
benchmarks. Many teachers worked last summer to create curriculum maps and submit lesson plans. 
These trainings will give you a chance to see and learn how to use the fruits of all of their hard work.  

I will also be coming to your buildings in February and March to offer Word 2000 Basics and Digital 
Camera Help sessions 

In March and April look for me at your staff meetings, where Elson Liu and I will talk about T4: 
Tomorrow’s Technology, Today’s Teachers. This technology integration workshop was a great success 
last summer and teaches both basic skills and integration techniques. Last year, the class was only 
offered to elementary and middle schoolteachers. This year the class will available for high school 
teachers as well. Look for further information in a later edition of the HPS TECH TIMES. 

Remember to keep smiling ~Carole ☺ 

 

Back to Top of Page 

  

Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

DELETING A HEADER OR FOOTER 
 
If you want to delete the headers or footers, follow these steps: 
 

1. Position the insertion point in the section that has the header       
you want to delete. 

2. If you are using Normal or Outline view, choose Header and Footer from 
the View menu. In Print Layout view, you can simply double-click on the 
Header or Footer you want to delete. You will see the Header and Footer 
dialog box, and the header area of the page. 

3. If you want to delete the footer, click on the Switch icon in the 
Header and Footer dialog box. 

4. Select the contents of the header or footer. 
5. Press the Del key, or press Ctrl+X. 
6. Click on Close. 

 
********************************************************************** 
 
SELECTING THE ENTIRE DOCUMENT WITH THE MOUSE 
 
If you need to select the entire document, you can do so with the mouse by 
following these steps: 
 

1. Move the mouse pointer to the left of the paragraphs in your      
document. The pointer changes to an arrow pointing up and to the right. 

2. Hold down the Ctrl key. 
3. Click the left mouse button. 

   
  

http://wordtipsgold@vitalnews.com/


   

   
  

Another way to do this is to simply triple-click the left mouse button after 
step 1. 
 
 
********************************************************************** 
COMPARING DOCUMENT VERSIONS 
 
Word includes a tool that allows you to compare two documents to each other. 
The document in memory is marked with revision marks to indicate the changes 
from the document on disk. To use this tool, you can follow these steps to 
compare documents: 
 

1. Load the newer version of the document into Word. 
2. Choose Track Changes from the Tools menu. This displays a submenu. 
3. Choose the Compare Documents option. You are prompted for a      

filename to use for the comparison. 
4. Select the file to which you want to compare the document. 
5. Click on OK. 

 
When the comparison is done, the document contains revision marks to indicate 
what has changed. Typically, new text is underlined and deleted text is 
struck through.   
 
****************************************
ADDING COMMENTS IN AN EXCEL SPREADSHEET 

****************************** 

 
Excel includes a very helpful feature that allows you to add comments to your 
worksheet. Each cell in the worksheet can have its own comment attached to 
it, if desired. Follow these steps to add comments: 
 

1. Select the cell to which you want a comment attached. 
2. Choose Comment from the Insert menu. A text box appears near the      

right corner of the cell. 
3. In the text box, enter the comment you want associated with the      

cell. 
4. Click outside the text box when you are done. 

 
The comment is now added to the cell. You should notice a small red triangle 
in the upper-right corner of the cell. When you move the mouse pointer over 
the cell, the text of the comment appears next to the pointer. You can also 
turn on all the comments in your worksheet so that you can see them by 
choosing Comments from the View menu. 
 
  
 
********************************
QUICKLY DELETING CELLS IN EXCEL 

************************************** 

 
Everyone knows that you can delete cells in an Excel spreadsheet by choosing 
Delete from the Edit menu. If you are typing away, however, it can be a pain 
to access the Delete dialog box in this manner. A quick way to accomplish the 
same task is to simply press Ctrl+- (the minus key, either on the regular 
keyboard or the numeric keypad). This pops up the Delete dialog box right 
away, allowing you to save a couple of mouse clicks. 
 
 
********************************************************************** 
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Great “Valentine Project” Links For You to Try…     

http://www.san-marino.k12.ca.us/~valentine/projects/scaveng1.html 

http://familycrafts.about.com/mbody.htm 

http://www.childfun.com/valentine/projects.shtml 

http://parentingteens.about.com/cs/craftsval/ 

http://www.hgtv.com/HGTV/project/0,1158,FOLI_project_22629,FF.html 

Back to Top of Page 

 

For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 

Back to Top of Page 

http://www.hps.k12.mi.us/Curriculum1.html
http://glen.cc/mtip/
http://www.remc7.k12.mi.us/oaisd/miclimb/
http://www.cyberlearning.org/
http://www.brainbuzz.com/topsites/Default.asp?CatID=1
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